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Regulatory Compliance

Thermo Electron San Jose performs complete testing and evaluation of its products to ensure full 
compliance with applicable domestic and international regulations. When your system is 
delivered to you, it meets all pertinent electromagnetic compatibility (EMC) and safety standards 
as follows:

EMC issues have been evaluated by EMC TECHNOLOGY SERVICES, A Subsidiary of 
UNDERWRITERS LABORATORY, INC (UL)

Safety Compliance
Low Voltage Directive EN 61010-1:2001

Please be aware that any changes that you make to your system may void compliance with one or 
more of these EMC and/or safety standards.
Making changes to your system includes replacing a part. Thus, to ensure continued compliance 
with EMC and safety standards, replacement parts should be ordered from Thermo Electron or 
one of its authorized representatives.

FCC Compliance Statement

Note: This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy. If it is not installed and used in accordance with the instruction manual, it may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference. In this case, the user will be required to correct the 
interference at his/her own expense.

EMC Certification

EN 55011 (1998) EN 61000-4-4 (1995)

EN 61326 (1998) EN 61000-4-5 (1995)

EN 61000-4-2 (1998) EN 61000-4-6 (1996)

EN 61000-4-3 (1996) EN 61000-4-11 (1994)

ENV 50204 (1995) FCC Class A
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Notice on Lifting and Handling of
Thermo Electron San Jose Instruments

For your safety, and in compliance with international regulations, the physical handling of this 
Thermo Electron San Jose instrument requires a team effort for lifting and/or moving the 
instrument. This instrument is too heavy and/or bulky for one person alone to handle safely.

Notice on the Proper Use of
Thermo Electron San Jose Instruments

In compliance with international regulations: If this instrument is used in a manner not 
specified by Thermo Electron San Jose, the protection provided by the instrument could be 
impaired.
TE SJ - 8 April 2003
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Read This First

Welcome to the Thermo Electron, Finnigan™ LTQ™ system!

This Finnigan LTQ Getting Connected manual provides you with 
information on how to connect your LTQ system.

This manual includes the following chapters:

Chapter 1: Line Power, Vacuum System, Gases, and Ethernet 
Communication describes how to connect the LTQ MS detector to line 
power, to the forepump, to the nitrogen gas, to the helium gas, and to the data 
system computer.

Chapter 2: Connecting Probes describes how to connect the LTQ MS 
detector to the ESI probe and APCI probe.

Chapter 3: Control of Inlet Devices describes how to connect external 
devices, how to connect devices that require contact closure, and how to 
trigger external devices.

Chapter 4: Connecting the Thermo Electron Finnigan Surveyor® LC 
System describes how to connect the LTQ MS detector to the Surveyor LC 
system.

Chapter 5: Connecting the Thermo Electron Finnigan 
SpectraSYSTEM® describes how to connect the LTQ MS detector to the 
SpectraSYSTEM equipped with an autosampler, pump, and UV detector.

Chapter 6: Connecting the Agilent® 1100 Series LC describes how to 
connect the LTQ MS detector to the Agilent 1100 Series LC system. 

Chapter 7: Upgrading the HP 1100 Series LC describes how to upgrade 
the Hewlett-Packard® 1100 Series LC communication interface to an Ethernet 
interface so that the LC system can be controlled by the Xcalibur data system.

Chapter 8: Connecting the Waters LC describes how to connect the 
TSQ Quantum to the Waters Alliance® and Alliance HT Separations Modules 
and to the Waters 2487 Dual λ Absorbance Detector.

Chapter 9: Connecting the SS420x Analog-to-Digital Interface Kit 
describes how to install and configure the SS420x.

Chapter 10: Connecting the 4-Port Serial PCB describes how to install the 
4-Port Serial PCB.

Chapter 11: Making Plumbing Connections to Run Samples on the LTQ 
MS detector describes how to connect plumbing for ESI/MS and APCI/MS 
sample introduction into the LTQ MS detector.
__________________ Finnigan TSQ Quantum Ultra Getting Connected ________________ iiiThermo
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Read This First
Changes to the Manual and Online Help __________________________________________Finnigan LTQ
Changes to the Manual and Online Help
To suggest changes to this manual or the online Help, please send your 
comments to:

Editor, Technical Publications
Thermo Electron San Jose
355 River Oaks Parkway
San Jose, CA 95134-1991
U.S.A.

You are encouraged to report errors or omissions in the text or index. 
Thank you.
Thermo
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Read This First
Finnigan LTQ __________________________________________________________________ Abbreviations
Abbreviations
The following abbreviations are used in this and other manuals and in the 
online Help.

A ampere

ac alternating current

ADC analog-to-digital converter

AP acquisition processor

APCI atmospheric pressure chemical ionization

API atmospheric pressure ionization

ASCII American Standard Code for Information 
Interchange

b bit

B byte (8 b)

baud rate data transmission speed in events per second

°C degrees Celsius

CD compact disc

CD-ROM compact disc read-only memory

cfm cubic feet per minute

CI chemical ionization

CIP carriage and insurance paid to

cm centimeter

cm3 cubic centimeter

CPU central processing unit (of a computer)

CRC cyclic redundancy check

CRM consecutive reaction monitoring

<Ctrl> control key on the terminal keyboard

d depth

Da dalton

DAC digital-to-analog converter

dc direct current

DDS direct digital synthesizer

DEP™ direct exposure probe

DS data system

DSP digital signal processor
___________________ Finnigan LTQ MS Detector Getting Connected _________________  vThermo
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Read This First
Abbreviations______________________________________________________________Finnigan LTQ
EI electron ionization

EMBL European Molecular Biology Laboratory

<Enter> enter key on the terminal keyboard

ESD electrostatic discharge

ESI electrospray ionization

eV electron volt

f femto (10-15)

°F degrees Fahrenheit

.fasta file extension of a SEQUEST search database file

FOB free on board

ft foot

FTP file transfer protocol

g gram

G giga (109)

GC gas chromatograph; gas chromatography

GC/MS gas chromatograph / mass spectrometer

GND electrical ground

GPIB general-purpose interface bus

GUI graphical user interface

h hour

h height

HPLC high-performance liquid chromatograph

HV high voltage

Hz hertz (cycles per second)

ICIS™ Interactive Chemical Information System

ICL™ Instrument Control Language™

ID inside diameter

IEC International Electrotechnical Commission

IEEE Institute of Electrical and Electronics Engineers

in. inch

I/O input/output

k kilo (103, 1000)

K kilo (210, 1024)

KEGG Kyoto Encyclopedia of Genes and Genomes

kg kilogram
Thermo
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Read This First
Finnigan LTQ __________________________________________________________________ Abbreviations
l length

L liter

LAN local area network

lb pound

LC liquid chromatograph; liquid chromatography

LC/MS liquid chromatograph / mass spectrometer

LED light-emitting diode

µ micro (10-6)

m meter

m milli (10-3)

M mega (106)

M+ molecular ion

MB Megabyte (1048576 bytes)

MH+ protonated molecular ion

min minute

mL milliliter

mm millimeter

MS mass spectrometer; mass spectrometry

MS MSn power:  where n = 1

MS/MS MSn power:  where n = 2

MSn MSn power:  where n = 1 through 10

m/z mass-to-charge ratio

n nano  (10-9)

NCBI National Center for Biotechnology Information 
(USA)

NIST National Institute of Standards and Technology 
(USA)

OD outside diameter

Ω ohm

p pico (10-12)

Pa pascal

PCB printed circuit board

PID proportional / integral / differential

P/N part number

P/P peak-to-peak voltage
___________________ Finnigan LTQ MS Detector Getting Connected ________________  viiThermo
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Read This First
Abbreviations______________________________________________________________Finnigan LTQ
ppm parts per million

psig pounds per square inch, gauge

RAM random access memory

RF radio frequency

RMS root mean square

ROM read-only memory

RS-232 industry standard for serial communications

s second

SIM selected ion monitoring

solids probe direct insertion probe

SRM selected reaction monitoring

SSQ® single stage quadrupole

TCP/IP transmission control protocol / Internet protocol

TIC total ion current

Torr torr

TSQ® triple stage quadrupole

u atomic mass unit

URL uniform resource locator

V volt

V ac volts alternating current

V dc volts direct current

vol volume

w width

W watt

WWW World Wide Web

Note. Exponents are written as superscripts. In the corresponding online 
Help, exponents are sometimes written with a caret (^) or with e notation 
because of design constraints in the online Help. For example:

MSn (in this manual) Ms^n (in the online Help)

105 (in this manual) 10^5 (in the online Help)
Thermo
ELECTRON CORPORATIONviii ___________________Finnigan LTQ MS Detector Getting Connected__________________



Read This First
Finnigan LTQ ________________________________________________________Typographical Conventions
Typographical Conventions
Typographical conventions have been established for Thermo Electron 
San Jose manuals for the following:

• Data input

• Boxed information

• Topic headings

Data Input
Throughout this manual, the following conventions indicate data input and 
output via the computer:  

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is represented in bold face letters. 
(Titles of topics, chapters, and manuals also appear in bold face letters.) 

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke.  For example, “press <F1>” means press the key labeled F1.

• Any command that requires pressing two or more keys simultaneously is 
shown with a plus sign connecting the keys. For example, “press 
<Shift> + <F1>” means press and hold the <Shift> key and then press the 
<F1> key.

• Any button that you click on the screen is represented in bold face letters 
and a different font. For example, “click on Close”.
___________________ Finnigan LTQ MS Detector Getting Connected ________________  ixThermo
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Read This First
Typographical Conventions____________________________________________________Finnigan LTQ
Boxed Information
Information that is important, but not part of the main flow of text, is 
displayed in a box such as the one below.

Boxed information can be of the following types:

• Note – information that can affect the quality of your data. In addition, 
notes often contain information that you might need if you are having 
trouble.

• Tip – helpful information that can make a task easier.

• Important – critical information that can affect the quality of your data.

• Caution – information necessary to protect your instrument from 
damage.

• CAUTION – hazards to human beings. Each CAUTION is accompanied 
by a CAUTION symbol. Each hardware manual has a blue CAUTION 
sheet that lists the CAUTION symbols and their meanings.

• DANGER – laser-related hazards to human beings. It includes 
information specific to the class of laser involved. Each DANGER is 
accompanied by the international laser radiation symbol.

Note. Boxes such as this are used to display information.
Thermo
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Topic Headings
The following headings are used to show the organization of topics within a 
chapter:

Chapter 1
Chapter Name

1.2 Second Level Topics

Third Level Topics

Fourth Level Topics

Fifth Level Topics
___________________ Finnigan LTQ MS Detector Getting Connected ________________  xiThermo
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Read This First
Reply Cards_______________________________________________________________Finnigan LTQ
Reply Cards
Thermo Electron San Jose manuals contain one or two reply cards. All 
manuals contain a Customer Registration / Reader Survey card and some 
contain a Change of Location card. These cards are located at the front of each 
manual.

The Customer Registration / Reader Survey card has two functions. First, 
when you return the card, you are placed on the Thermo Electron San Jose 
mailing list. As a member of this list, you receive application reports and 
technical reports in your area of interest, and you are notified of events of 
interest, such as user meetings. Second, it allows you to tell us what you like 
and do not like about the manual. 

The Change of Location card allows us to track the whereabouts of the 
instrument. Fill out and return the card if you move the instrument to another 
site within your company or if you sell the instrument. Occasionally, we need 
to notify owners of our products about safety or other issues.
Thermo
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Chapter 1
Line Power, Vacuum System, Gases,

and Ethernet Communication

This chapter describes how to connect the LTQ MS detector to line power, to 
the forepump, to the necessary gases, and to the data system computer.

The following topics are discussed in this chapter:

• Connecting the LTQ MS Detector to Line Power

• Connecting the LTQ MS Detector to the Forepumps

• Connecting Gases to the LTQ MS Detector

• Connecting the LTQ MS Detector to the Data System Computer
_________________ Finnigan LTQ MS Detector Getting Connected _________________  1-1Thermo
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Line Power, Vacuum System, Gases, and Ethernet Communication
Connecting the LTQ MS Detector to Line Power_____________________________________Finnigan LTQ
1.1 Connecting the LTQ MS Detector 
to Line Power

To connect the LTQ MS detector to line power, proceed as follows: 

1. Locate the MAIN POWER circuit breaker switch on the LTQ MS detector 
Power Entry Module. 

2. Turn the circuit breaker switch to the Off (O) position.

3. Locate the Electronics switch and make sure that the switch is in the 
Service Mode position.

4. Connect the power cord from the POWER IN inlet located on the LTQ 
MS detector Power Entry Module, to the 230 V ac power source in 
your laboratory.

Caution. If your local area is subject to power fluctuations or power 
interruptions, a power conditioning device or an uninterruptible power 
supply (UPS) should be installed in your laboratory. (Refer to the topic 
Power Conditioning Devices in the LTQ MS detector Preinstallation 
Requirements Guide.)
Thermo
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Line Power, Vacuum System, Gases, and Ethernet Communication
Finnigan LTQ ____________________________________ Connecting the LTQ MS Detector to the Forepumps
1.2 Connecting the LTQ MS Detector 
to the Forepumps

To connect the LTQ MS detector to the forepumps, proceed as follows:

1. Using a hose clamp (P/N 00108-09001), connect the 3.8 cm (1.5 in.) ID 
reinforced vacuum hose to the LTQ MS detector vacuum inlet. (The 
vacuum hose inlet is located on the left side panel of the LTQ MS 
detector.)

2. Connect the 3.8 cm (1.5 in.) Tee (P/N 97055-20222) to the free end of the 
vacuum hose with a hose clamp (P/N 00108-09001).

3. Using hose clamps (P/N 00108-09001), connect the 3.8 cm (1.5 in.) ID 
reinforced vacuum hoses to the other branches of the Tee connector.

4. Connect a pump fitting adapter (P/N 00108-09005) to the free end of the 
vacuum hoses with a hose clamp (P/N 00108-09001).

5. Place a centering ring (P/N 00108-02011) on the flange of each forepump 
vacuum inlet.

6. Connect the vacuum hose (with the attached fitting adapter) to the pump 
vacuum inlet. Secure the hose to the pump using the KF20/25 vacuum 
hardware clamp (P/N 00102-10020).

7. Use hose clamps (P/N 00108-09001) to connect the 2.5 cm (1 in.) ID blue 
exhaust hoses from the forepump exhaust ports to the pump exhaust 
system in your laboratory. The exhaust hoses should travel at floor 
level and should extend no more than two meters (78.5 in.) above the 
level of the forepumps.

8. Connect the forepumps to line power, as follows:

a. Locate the Main Power circuit breaker switch on the Power Entry 
Module and switch the circuit breaker to the Off (O) position.

b. Connect the power cords attached to the forepumps to the forepump 
outlets located on the Power Entry Module.

Note. An efficient fume exhaust system is required for the proper operation 
of your forepumps. Most API applications will contribute to the 
accumulation of solvents in the forepumps. These solvents must be purged 
from the mechanical pump oil periodically by opening the ballast valve 
located on the top of the pump. When the ballast valve is opened, a large 
volume of volatile solvent waste might enter the fume exhaust system. 
Therefore, your fume exhaust system must be able to accommodate the 
effluent resulting from periodic purging. The frequency of the purging is 
dependent on the throughput of your system.
_________________ Finnigan LTQ MS Detector Getting Connected _________________  1-3Thermo
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Line Power, Vacuum System, Gases, and Ethernet Communication
Connecting Gases to the LTQ MS Detector ________________________________________Finnigan LTQ
1.3 Connecting Gases to the LTQ MS 
Detector

This topic describes how to connect the required gases to the LTQ MS 
detector. The following topics are included:

• Connecting nitrogen gas to the LTQ MS detector

• Connecting helium gas to the LTQ MS detector

Connecting Nitrogen Gas to the LTQ MS 
Detector
the LTQ MS detector requires high-purity (99%) nitrogen for the API sheath 
gas and auxiliary gas. Nitrogen gas usage can be quite high. Therefore, it is 
recommended that nitrogen gas be supplied from one of three sources as 
follows: a large, sealed, thermally insulated cylinder containing liquid 
nitrogen, from which the nitrogen gas is boiled off from the liquid; the largest 
nitrogen cylinder that can be practically used; or a nitrogen generator. The 
required gas pressure is 690 ± 140 kPa (100 ± 20 psi).

Connect nitrogen gas to the LTQ MS detector, as follows: 

1. Connect an appropriate length of 1/4-in. ID Teflon® tubing with a brass 
Swagelok®-type 1/4-in. nut (P/N 00101-12500) and a 2-piece brass 
1/4-in. ferrule [P/N 00101-10000 (front), P/N 00101-04000 (back)] to the 
nitrogen source. See Figure 1-1 for the proper orientation of the fitting 
and ferrule.

2. Connect the opposite end of the Teflon tubing to the LTQ MS detector 
press-in fitting labeled NITROGEN IN located on the left side panel of 
the LTQ MS detector. Connect the tubing by aligning the Teflon tubing 
with the opening in the fitting and firmly pushing the tubing into the 
fitting until the fitting holds the tubing securely.

Helium
The helium for LTQ MS detector collision gas must be ultra-high purity 
(99.999%) with less than 1.0 ppm each of water, oxygen, and total 
hydrocarbons. The required gas pressure is 275 ± 70 kPa (40 ±10 psi). 
Particulate filters can be a source of contamination, they are not 
recommended.

Helium can be dispensed from a tank containing 245 ft3 of gas using a 
Matheson 3120 Series1 regulator or equivalent tank and regulator.

1For more information, visit: http://www.matheson-trigas.com
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Line Power, Vacuum System, Gases, and Ethernet Communication
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The gas lines for helium can be copper or stainless steel. All gas lines need to 
be free of oil and preferably flame dried. Run the gas lines to the left side of 
the LTQ MS detector system. Terminate the helium gas supply lines with 
1/8-in., female, Swagelok-type connectors.

1. Connect an appropriate length of 1/8-in. ID copper or stainless steel 
tubing with a brass Swagelok-type 1/8-in. nut (P/N 00101-15500) and a 
2-piece brass 1/8-in. ID ferrule [P/N 00101-08500 (front), 
P/N 00101-2500 (back)] to the HELIUM IN gas inlet located on the LTQ 
I/O panel. (See Figure 1-1 for the proper orientation of the fitting and 
ferrule.)

2. Connect the opposite end of the tubing to the helium gas source using an 
appropriate fitting.

Figure 1-1. Proper orientation of the Swagelok-type nut and two-piece ferrule

Gas Hose

Swagelok-Type Nut

Front Ferrule

Back Ferrule
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1.4 Connecting the LTQ MS Detector 
to the Data System Computer

The LTQ MS detector data system consists of a computer, a monitor, and an 
optional printer. the LTQ MS detector communicates with the data system 
computer through an Ethernet cable. To connect the Ethernet cable, proceed 
as follows: 

1. Connect a category five network (Ethernet) cable (P/N 00302-01838) to 
the ETHERNET 100 BASE T connector located on the LTQ MS detector 
Power Entry Module.

2. Connect the opposite end of the Ethernet cable to the 10/100BaseT 
Ethernet switch (P/N 00825-01015) provided with the LTQ MS detector.

3. Connect a second Ethernet cable (P/N 00302-01838) from the Ethernet 
switch to the Ethernet card on the data system computer labeled 
Surveyor LC and LTQ.

4. Plug in the power supply for the Ethernet switch.
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Chapter 2
Connecting Probes

This chapter describes how to connect an ion source probe to the LTQ MS 
detector.

The following topics are discussed in this chapter:

• Connecting the ESI Probe to the LTQ MS Detector

• Connecting the APCI Probe to the LTQ MS Detector
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2.1 Connecting the ESI Probe to the 
LTQ MS Detector 

Connect liquid lines to the ESI probe as follows:

1. Install the Ion Max source housing and ESI probe onto the LTQ MS 
detector as described in the Finnigan Ion Max API Source Hardware 
Manual.

2. Install liquid lines, as necessary, between the divert/inject valve, the LC 
system, the syringe pump, and the grounding union, as is appropriate for 
your application, in accordance with the associated drawing in the topic 
Plumbing Connections for ESI/MS on page 11-4.

3. Connect the 1-in. ID Tygon® tubing (P/N 00301-22922) to the source 
housing drain fitting. Insert the exit end of the tubing into a waste 
container. Ideally, the waste container should be vented to a fume exhaust 
system.

Caution. Prevent solvent waste from backing up into the API source and 
mass spectrometer. Always ensure that the PVC drain tubing is above the 
level of liquid in the waste container.

Caution. Do not vent the PVC drain tube (or any vent tubing connected to 
the waste container) to the same fume exhaust system to which you have 
connected the forepumps. The analyzer optics can become contaminated if 
the API source drain tube and the (blue) exhaust tubing from the forepumps 
are connected to the same fume exhaust system.

Your laboratory must be equipped with at least two fume exhaust systems. 
Route the (blue) exhaust tubing from the forepumps to a dedicated fume 
exhaust system. Route the PVC drain tube from the API source to the waste 
container. Vent the waste container to a dedicated fume exhaust system.
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2.2 Connecting the APCI Probe to the 
LTQ MS Detector 

Connect liquid lines to the APCI probe as follows:

1. Install the Ion Max source housing and APCI probe onto the LTQ MS 
detector as described in the Finnigan Ion Max API Source Hardware 
Manual.

2. Install liquid lines, as necessary, between the divert/inject valve, the LC 
system, the syringe pump, and the sample inlet fitting on the APCI
probe, as is appropriate for your application, in accordance with the 
associated drawing in the topic Plumbing Connections for APCI/MS on 
page 11-11.

3. Connect the 1-in. ID Tygon® tubing (P/N 00301-22922) to the source 
housing drain fitting. Insert the exit end of the tubing into a waste 
container. Ideally, the waste container should be vented to a fume exhaust 
system.

Caution. Prevent solvent waste from backing up into the API source and 
mass spectrometer. Always ensure that the PVC drain tubing is above the 
level of liquid in the waste container.

Caution. Do not vent the PVC drain tubing (or any vent tubing connected to 
the waste container) to the same fume exhaust system to which you have 
connected the forepumps.

Note. If you need to install or replace the APCI sample tube, refer to the 
topic API Source Maintenance in the LTQ MS detector Hardware 
Manual for instructions.
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Chapter 3
Control of External Devices

This chapter describes how to connect the LTQ MS detector to external 
devices.

This chapter contains the following sections:

• External devices controlled by the Xcalibur® data system

• External devices not controlled by the Xcalibur data system
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3.1 External Devices Controlled by 
the Xcalibur Data System

The Xcalibur data system allows for the control of external devices (e.g., 
autosamplers, pumps, and detectors) from several manufacturers including 
Thermo Electron, Agilent1, and Waters. The LTQ MS detector can start data 
acquisition from an external device upon receiving a contact closure (closed 
contact or open contact) signal from the device. The LTQ MS detector 
receives contact closure signals through a 2-wire trigger cable (in kit 
P/N OPTON-21705) connected to the LTQ MS detector START IN port. 
Figure 3-1 shows a simplified block diagram of the LTQ MS detector contact 
closures to an external device.

1 Formerly Hewlett-Packard® (HP)

Note. The external device providing the start signal must have a good 
ground. Ground loops can cause problems.

Caution. Care must be taken with the CMOS that resides on the LTQ MS 
detector PLL PCB. The CMOS will fail if more than 5 V or 5 mA is applied 
to the system.

Figure 3-1. Portion of the power entry module showing contact closures for the LTQ MS detector 
and an external device

Inlet Device

Contact Closure

Relay Contact

TTL Logic

Two Wire Trigger Cable

(In Kit Opton-21705)

Peripheral Control
Start 

In

Ready 

Out

Start 

Out

Analog Input
1V Max 10V MAX

Power In

230 V AC 

10A

Peripheral Control
Start 

In
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Table 3-1 lists the Xcalibur kits for various external devices.

Table 3-1. Xcalibur kits for various external devices 

Part Number Description of Kit

OPTON-21705 Xcalibur Contact Closure Kit
(for devices not controlled by Xcalibur)
2-wire trigger cable
8-position screw connector

OPTON-21706 Xcalibur SpectraSYSTEM Interface Kit
SpectraSYSTEM 9.05 EPROM for SN4000
EPROM removal tool
Contact Closure Wiring Harness
2-wire trigger cable (contact closure)

OPTON-21709 Xcalibur Additional 4-Port Serial Kit
4-Port Serial PCB (PCI) and software
Quad DB9 male adapter

OPTON-21710 Xcalibur Waters Interface Kit
Waters serial I/F cable
2-wire trigger cable (contact closure)

OPTON-21721 Xcalibur SS420x Interface Kit
SS420x main unit
serial cable
2-wire trigger cable (contact closure) 
power supply
Xcalibur Additional 4-Port Serial Kit

OPTON-30018 Xcalibur JetDirect® Ethernet Control Kit
Contact closure PCB
External contact closure cable
Ethernet 10 Base-T cable (2)
10/100 Autosensing 8-port Ethernet switch
HP JetDirect 400N PCB
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3.2 External Devices Not Controlled 
by the Xcalibur Data System

External devices that are not controlled by the Xcalibur data system must be 
properly connected for contact closure and configured in the Xcalibur Run 
Sequence dialog box as follows:

1. Connect the 2-wire trigger cable (in kit P/N OPTON-21705) from the 
LTQ MS detector power entry module to the contact closure terminal of 
the external device following the wiring scheme shown in Table 3-2. 

Table 3-2. Wiring the LTQ MS detector and an external device (not 
controlled by the Xcalibur data system) for contact 
closure 

2. Use the Xcalibur data system Run Sequence dialog box to configure the 
data system for the external device:

a. On the Xcalibur Home Page, choose View > Info View to open the 
Status Page (if it is not already open). 

b. In the Sequence Setup window make sure there is an active method 
and then choose Actions > Run Sequence or Actions > Run 
This Sample to open the Run Sequence dialog box. See Figure 3-2.

c. Click on Change Instruments to open the Change Instruments 
In Use dialog box. See Figure 3-3.

The LTQ MS detector should not be in the Start Instrument: Yes 
mode. Observe the Acquisition Options group box.

• If the LTQ MS detector is in the Start Instrument: Yes mode, go to 
step d.

• If the LTQ MS detector is not in the Start Instrument: Yes mode, 
click on OK to close the dialog box and go on to step 3.

Note. The output (start) signal from the external device must be Normally Hi 
(+5 V) and go to Low momentarily to start data acquisition on the LTQ MS 
detector. If the external device cannot be configured to go from Normally Hi 
to Low momentarily, it cannot be used with the LTQ MS detector.

LTQ MS detector 
Power Entry Module

External Device 
Contact Closure Terminal

TTL IN 1 Output (start) terminal 

DIGITAL GROUND Ground terminal
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d. In the LTQ MS detector row of the Start Instrument column, click on 
Yes to change the mode to Off (field is blank), then click on OK to 
save the setting and close the dialog box.

3. In the Acquisition Options group box select the Start When Ready check 
box, then click on OK to save the settings, close the dialog box, and start 
the sequence or queue it. The instrument method is downloaded to the 
LTQ MS detector and the Status Page displays Waiting - Contact Closure.

4. Push the start button on the external device to start the external device, the 
LTQ MS detector, and the acquisition of data. 

Figure 3-2.Run Sequence dialog box 
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Figure 3-3. Change Instruments In Use dialog box

LTQ MS Is Not Selected as a 
Start Instrument
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Chapter 4
Connecting the Thermo Electron

Finnigan Surveyor LC System

This chapter describes how to connect the LTQ MS Detector to the 
Thermo Electron Finnigan Surveyor LC System. 

This chapter contains the following sections:

• Connecting the Hardware 

• Connecting the Plumbing

Table 4-1 lists the Xcalibur supported firmware for the Surveyor LC system.

Table 4-1. Xcalibur supported firmware versions for the Surveyor LC 

Module Firmware Version

LC pump

Converter board ROM 1.08

Converter board RAM 1.15

Main pump board 1.00

Autosampler

Autosampler ROM 1.08

Autosampler RAM 2.13

PDA detector

Converter board ROM 1.07

Converter board RAM 1.17

Main PDA board RAM 1.8

Main PDA board ROM (Mon960) 0.2

Main PDA board PIC processor 7.00

UV/Vis detector

Converter board ROM 1.07

Converter board RAM 1.06

Main detector board 3.12
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4.1 Connecting the Hardware
To connect the LTQ MS Detector and data system to a Surveyor LC system 
equipped with a PDA or UV/Vis detector, proceed as follows:

1. Stack the Surveyor modules in the following order from bottom to top: 
Surveyor Pump, Surveyor Autosampler, Surveyor Detector, and Surveyor 
Solvent Platform. See Figure 4-1.

2. Interconnect the Surveyor modules with the System Synchronization 
Wiring Harness (P/N F5049-010). The connectors on the System 
Synchronization Wiring Harness are labeled appropriately. See Figure 4-2 
or Figure 4-3.

When the System Synchronization Wiring Harness is properly connected, 
one connector is not used. If you are using the MS Pump, the connector 
labeled LC Pump is not used; if you are using the LC Pump, the connector 
labeled MS Pump is not used.

Figure 4-1. Surveyor LC system, with MS Pump and PDA Detector

Solvent Platform

Detector

Autosampler

Pump
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3. Connect the two pin end of the (P/N 70111-63136) cable to the START IN 
connection on the LTQ MS Detector power entry module.

4. Connect the other end of the Adapter LC/MS Interconnect to the System 
Synchronization Wiring Harness from step 2.

5. Connect the communication cable for the pump:

a. If you are using the Surveyor MS Pump, connect the 9-pin serial 
cable (P/N 72011-63008) from the pump RS-232 connector to the 
computer COM1 serial communication port (or another available 
port). See Figure 4-2.

b. If you are using the Surveyor LC Pump, connect an Ethernet cable 
(P/N F5048-020) from the Surveyor LC Pump ENET connector to the 
Ethernet switch (P/N 00825-01015). See Figure 4-3.

6. If you are using the Surveyor MS Pump, configure the COM1 serial port 
as follows. Otherwise, go to step 7.

a. Choose Start > Settings > Control Panel, then click on the 
System icon to open the System Properties dialog box.

b. Click on the Hardware tab, and then click on Device Manager.

c. Double-click on Ports (COM & LPT). The available ports are 
displayed below Ports (COM & LPT) in the Device Manager list.

d. Double-click on Communication Port (COM1) to display the 
Communication Port (COM1) Properties dialog box.

e. Click on the Port Setting tab.

f. Set the configuration parameters:

Bits per Second 19200
Data Bits 8
Parity none
Stop Bits 1
Flow Control none

g. Click on OK to save the changes and close the Communication Port 
(COM1) Properties dialog box.

h. Close the Device Manager window by clicking on the Close button in 
the title bar.

Note. If your data system computer does not have a sufficient number of 
COM ports available, you might need to install the 4-port serial PCB as 
discussed in Chapter 10: Connecting the 4-Port Serial PCB.

Note. Use only the standard ports on the Ethernet switch for the Surveyor 
connections.
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i. Click on OK to close the System Properties dialog box.

j. Restart the computer to enable the new settings. 

7. Connect a Category 5 network (Ethernet) cable (P/N 00302-01838) from 
the Surveyor PDA ENET connector to one of the standard ports on the 
Ethernet switch (P/N 00825-01015). See Figure 4-2 or Figure 4-3 for a 
wiring diagram.

8. Connect an Ethernet cable (P/N 00302-01838) from the Surveyor 
Autosampler ENET connector the Ethernet switch.

9. Connect an Ethernet cable (P/N 00302-01838) from the Ethernet switch 
to the computer 3Com 3C900B-TX Ethernet card labeled Surveyor.

10. Connect an Ethernet cable (P/N 00302-01838) from the Ethernet switch 
to the LTQ MS Detector Ethernet connection on the power entry module.

11. Confirm that the 3Com 3C905B-TX Ethernet card is assigned to the LTQ 
MS Detector and the Surveyor LC System:

a. Choose Start > Settings > Control Panel, then double-click on 
the Network and Dial-up Connections icon to open the Network and 
Dial-up Connections dialog box.

b. Right-click on the Local Area Connection 3 icon and then choose 
Properties from the shortcut menu. The Local Area Connection 
Properties dialog box opens.

c. Select Internet Protocol (TCP/IP) from the Components Checked Are 
Used By This Connection list box. Click on Properties to open the 
Internet Protocol (TCP/IP) Properties dialog box.

d. Confirm that the IP address for the 3Com 3C905B-TX Ethernet card 
is 172.16.0.101 as in Table 4-2. 

e. Click on OK to close the Internet Protocol (TCP/IP) Properties dialog 
box, and then click on OK to close the Network dialog box.

Table 4-2.Data system computer configured with three (3) Ethernet cards

Slot Ethernet Card Use IP Address Subnet mask

1 3Com 3C900B-TPC LCQ Series 
Instruments

10.0.0.101 255.255.255.0

2 3Com 3C905B-TX User’s Network 192.x.x.x 255.255.255.0

3 3Com 3C905B-TX LTQ MS 
Detector and 
Surveyor LC 
System

172.16.0.101 255.255.0.0
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Figure 4-2.Cable diagram for the Surveyor LC system with an MS Pump, LTQ MS Detector, and data
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Figure 4-3. Cable diagram for the Surveyor LC system with an LC Pump, LTQ MS Detector, and data 
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4.2 Connecting the Plumbing
The following procedure assumes that a Thermo Electron service 
representative has set up your Surveyor LC system and has done the 
following: 

• Mounted the syringe drive assembly to the front of the Surveyor 
Autosampler

• Installed the flowcell in the optional Surveyor PDA detector or Surveyor 
UV/Vis detector

• Assembled the solvent reservoir bottles

• Connected the Super Flangeless™ fittings to the four solvent lines. 

For more detailed instructions on connecting a Surveyor LC system, refer to 
the Finnigan Surveyor Getting Connected manual.

Plumb the Surveyor modules as follows:

1. Connect the Teflon tubing (with fitting and ferrule) from the wash bottle 
to the left side of the syringe valve. See Figure 4-5.

2. Connect the solvent reservoir tubing to the analytical pump:

a. Feed the Teflon tubing from the solvent bottles through the guide 
slots located on the left side of the Surveyor modules.

b. Connect the Super Flangeless fittings to the inlets of the degassing 
chamber located on the MS Pump or LC Pump. 

A Super Flangeless fitting properly swaged onto the end of a 1/8-in 
OD solvent reservoir tubing is shown in Figure 4-6.

c. Use the (black) tubing clamps located on the inside left of the 
Surveyor Autosampler to secure the tubing.

3. Connect the autosampler to the pump:

a. Depending on your autosampler model, do one of the following:

• For the Surveyor Autosampler Lite, use the bushing 
(P/N 2522-0066) and the ferrule (P/N 2522-3830) that come in 
the autosampler accessory kit to attach the 12-in. l, 0.010-in. ID, 
stainless steel tubing (P/N A0941-010) that also comes in the kit 
to port 5 of the Rheodyne injection valve. See Figure 4-7.

• For the Surveyor Autosampler, pull the stainless steel tubing that 
exits the column oven of the autosampler forward and then 
downward through the access port in the bottom of the 
autosampler as shown in Figure 4-8.

Note. Each numbered step in the procedure corresponds to a highlighted 
number in Figure 4-4.
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b. Place the fingertight nut and ferrule set (P/N 00101-18088) onto the 
free end of the stainless steel tubing. Then, attach the tubing to the 
pump.

• For the MS pump, screw the fitting into the outlet port of the 
pulse dampener (Figure 4-7). 

• For the LC pump, screw the fitting into the in-line filter body on 
the top of the purge manifold (Figure 4-8).

4. Connect port 6 of the Rheodyne injection valve to the inlet of your LC 
column by using an appropriate length of tubing, a Rheodyne nut 
(P/N 3522-0066) and a Rheodyne ferrule (P/N 2522-3830). The six ports 
of the Rheodyne injection valve are labeled in Figure 4-9.

5. Connect the outlet of the LC column to the inlet of the flowcell.

a. If your system contains a detector with a LightPipe flowcell, the 
tubing connected to the inlet of the flowcell is red, insulated, 
0.005-in. ID PEEK tubing. The connections to a Surveyor UV/Vis 
detector with a LightPipe flowcell are shown in Figure 4-10.

b. If your system contains a Surveyor UV/Vis detector with a standard 
1 cm flowcell, connect the 0.010-in. ID stainless steel tubing from the 
flowcell inlet to the column outlet.

6. Connect the outlet of the flowcell to the inlet of the MS detector. Use 
1/16-in. fittings and the red, 0.005-in. ID, PEEK tubing that is included in 
the MS accessory kit to connect a LightPipe flowcell. If the your system 
contains a Surveyor UV/Vis detector with a standard flowcell, connect the 
0.010-in. ID stainless steel outlet tubing to the inlet of the MS detector. If 
necessary, use a connector and additional tubing.

Tip. If you need to decrease the gradient delay volume of your system, 
bypass the tubing behind the column oven. This tubing allows the mobile 
phase to equilibrate to the requested column oven temperature, but it also 
adds 250 µL of gradient delay volume to your system. To bypass this tubing, 
disconnect it from port 5 of the Rheodyne injection valve. After you 
disconnect the column oven tubing, use another piece of tubing to connect 
the outlet of the pulse dampener directly to port 5 of the injection valve.

Caution. If your system contains a Surveyor UV/Vis detector with a 
LightPipe flowcell, never remove the LightPipe flowcell from the LightPipe 
mounting assembly without first removing the photodiode mounting 
assembly. If you want to remove the LightPipe flowcell from its mounting 
assembly, refer to the Finnigan Surveyor Getting Connected manual.

Note. You need to configure the modules of your Surveyor LC System 
before you run samples. Refer to the Finnigan Surveyor Getting Started 
with Xcalibur manual for information on configuring the modules.
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Figure 4-4. Plumbed Surveyor Stack
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Figure 4-5. Wash bottle tubing connection to syringe valve, showing 
brackets
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Figure 4-6. Solvent reservoir tubing with Super Flangeless fitting
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Figure 4-7. Connection between Surveyor Autosampler Lite and 
MS Pump
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Figure 4-8. Surveyor LC Pump connected to Full Featured Surveyor Autosampler
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Figure 4-9. Six-Port Rheodyne Injection Valve (7739)
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Chapter 5
Connecting the Thermo Electron

Finnigan SpectraSYSTEM

The Xcalibur data system allows control of the Thermo Electron Finnigan 
SpectraSYSTEM® 1 with autosampler (AS3000, AS3500), pump (P2000, 
P4000), and UV detector (UV2000, UV6000LP).

This chapter contains the following sections:

• Connecting to a SpectraSYSTEM with a UV2000 Detector

• Connecting to a SpectraSYSTEM with a UV6000LP Detector

• Configuring the Autosampler and Pump

Table 5-1 lists the Xcalibur kit used with the SpectraSYSTEM.

Table 5-1. Xcalibur kit used with the SpectraSYSTEM 

1 Formerly Thermo Separation Products (TSP) SpectraSYSTEM

Part Number Description of Kit

OPTON-21706 Xcalibur SpectraSYSTEM Interface Kit
SpectraSYSTEM 9.05 EPROM for SN4000
EPROM removal tool
Contact Closure Wiring Harness
2-wire trigger cable (contact closure)
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Table 5-2 lists the Xcalibur supported firmware for the SpectraSYSTEM.

Table 5-2. Xcalibur supported firmware versions for the 
SpectraSYSTEM

*To obtain the firmware version for a module, push the <MENU> key on the keypad, then use the < _ > 
key to select TESTS. Press the <ENTER> key twice to display the Software Version.

Table 5-3 lists the reference manuals for the SpectraSYSTEM.

Table 5-3. SpectraSYSTEM reference manuals

Module Model Number Firmware Version*

Binary pump P2000 4.03

Quaternary pump P4000 4.04

Autosampler AS3000/3500 3.44

UV/VIS detector UV2000 3.13

Photo diode array detector UV6000LP 1.00

Serial interface SN4000 9.05

Module Model 
Number

Reference Manual

Binary pump P2000 SpectraSYSTEM & SpectraSERIES Gradient Pump 
Reference Manual

Quaternary pump P4000 SpectraSYSTEM & SpectraSERIES Gradient Pump 
Reference Manual

Autosampler AS3000/3500 SpectraSYSTEM & SpectraSERIES Autosampler 
Reference Manual

UV/VIS detector UV2000 SpectraSYSTEM UV/VIS Detector Reference Manual

Photo diode array 
detector

UV6000LP UV6000LP Detector Reference Manual
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5.1 Connecting to a SpectraSYSTEM 
with a UV2000 Detector

For additional information about your SpectraSYSTEM modules refer to the 
manuals listed in Table 5-3.

To connect the LTQ MS detector to a SpectraSYSTEM equipped with a 
UV2000 detector, proceed as follows:

1. Interconnect the pump, autosampler, and the UV2000 detector with the 
Contact Closure Wiring Harness. Follow the wiring scheme shown in 
Figure 5-1.

2. Connect the SN4000 (P/N A3625-073) to the pump, autosampler, 
UV2000 detector, and the data system computer: (Figure 5-1)

a. Turn the SN4000 power switch to Off and disconnect the 12 V dc 
power supply.

b. Turn the SN4000 upside down to access the four Phillips-head screws 
that secure the top cover to the case.

c. Remove the screws and slide the top cover off to expose the SN4000 
PCB and the RJ11 and RJ45 ports.

d. Verify that the EPROM firmware version 9.05 (P/N A4636-129) is 
installed in socket U12 located on the SN4000 PCB. Sockets U11, 
U28, and U29 should be empty. Verify that the correct firmware is 
installed in the pump, autosampler, and UV detector. (Refer to 
Table 5-2 on page 5-2.)

e. Connect one RJ11 6-pin, 4-wire cable from the PUMP port located on 
the SN4000 PCB to the COM port located on the rear of the pump. 
(Route all cables through the access hole located in the rear panel of 
the SN4000.)

f. Connect another RJ11 6-pin, 4-wire cable from the A/S port located 
on the SN4000 PCB to the COM port located on the rear of the 
autosampler.

g. Connect a third RJ11 6-pin, 4-wire cable from the DET 1 port located 
on the SN4000 PCB to the COM port located on the rear of the 
UV2000 detector.

Caution. Before you remove the top cover of the SN4000, turn the power 
switch located on the rear of the SN4000 to Off, and disconnect the 12 V dc 
power supply.
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h. Connect an RJ45 8-pin, 8-wire cable from the COM port located on 
the SN4000 PCB to an RJ45 to DB9 adapter.

i. Connect the DB9 adapter and the attached cable to the RS-232 port 
(labeled A) located on the rear of the data system computer. 

j. Reinstall the SN4000 top cover and mounting screws.

k. Reconnect the power cable from the 12 V dc power supply to the 
Power In inlet located on the rear of the SN4000.

3. Connect the 2-wire trigger cable (in kit P/N OPTON-21706) from the 
LTQ MS detector power entry module to the contact closure terminal 
located on the rear of the autosampler following the wiring scheme shown 
in Figure 5-1.

4. Use the Xcalibur data system Instrument Configuration dialog box to 
assign the RS-232 connection from the SN4000 to COM1 (port A) of the 
data system computer:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the TSP SN4000 button. The TSP SN4000 button is copied to the 
Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the TSP SN4000 button in the Configured Devices 
group box. Xcalibur opens the TSP SN4000 Configuration dialog 
box. See Figure 5-2.

d. Select COM1 in the Serial Port list box, then click on OK to save the 
setting and close the dialog box.

Go to Configuring the Autosampler and Pump on page 5-10.

Figure 5-2. SN4000 Configuration dialog box
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5.2 Connecting to a SpectraSYSTEM 
with a UV6000LP Detector

For additional information about your SpectraSYSTEM modules, refer to the 
manuals listed in Table 5-3.

To connect the LTQ MS detector to a SpectraSYSTEM equipped with a 
UV6000LP detector, proceed as follows:

1. Interconnect the pump, autosampler, and UV6000LP with the Contact 
Closure Wiring Harness. Follow the wiring scheme shown in Figure 5-3.

2. Connect the SN4000 (P/N A3625-073) to the pump, autosampler, and 
data system computer: (Figure 5-3)

a. Turn the SN4000 power switch located on the rear of the module to 
Off and disconnect the 12 V dc power supply.

b. Turn the SN4000 upside down to access the four Phillips-head screws 
that secure the top cover to the case.

c. Remove the screws and slide the top cover off to expose the SN4000 
PCB and the RJ11 and RJ45 ports.

d. Verify that the EPROM firmware version 9.05 (P/N A4636-129) is 
installed in socket U12 located on the SN4000 PCB. Sockets U11, 
U28, and U29 should be empty. Verify that the correct firmware is 
installed in the pump, autosampler, and UV detector. (Refer to 5-2.)

e. Connect one RJ11 6-pin, 4-wire cable from the PUMP port located on 
the SN4000 PCB to the COM port located on the rear of the pump. 
(Route all cables through the access hole located in the rear panel of 
the SN4000.)

f. Connect another RJ11 6-pin, 4-wire cable from the A/S port located 
on the SN4000 PCB to the COM port located on the rear of the 
autosampler.

g. Connect the RJ45 8-pin, 8-wire cable from the COM port located on 
the SN4000 PCB to an RJ45 to DB9 adapter.

h. Connect the DB9 adapter and the attached cable to the RS-232 port 
(labeled A) located on the rear of the data system computer.

i. Reinstall the SN4000 top cover and mounting screws.

Caution. Before you remove the top cover of the SN4000, turn the power 
switch to Off, and disconnect the 12 V dc power supply.
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j. Reconnect the power cable from the 12 V dc power supply to the 
Power In inlet located on the rear of the SN4000.

3. Connect the UV6000LP detector to the data system computer: (See 
Figure 5-3.)

a. Connect an RJ45 8-pin, 8-wire cable to the RS-232 port located on 
the rear of the UV6000LP detector.

b. Connect the other end of the RJ45 8-pin, 8-wire cable to an RJ45 to 
DB9 adapter.

c. Connect the DB9 adapter and the attached cable to the RS-232 port 
(labeled A) located on the rear of the data system computer.

4. Connect the 2-wire trigger cable (in kit P/N OPTON-21706) from the 
LTQ MS detector power entry module to the contact closure terminal 
located on the rear of the autosampler following the wiring scheme shown 
in Figure 5-3.

5. Use the Xcalibur data system Instrument Configuration dialog box to 
assign the RS-232 connection from the SN4000 to COM1 (port A) or 
another available port of the data system computer:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the TSP SN4000 button. The TSP SN4000 button is copied to the 
Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the TSP SN4000 button in the Configured Devices 
group box. Xcalibur opens the SN4000 Configuration dialog box. See 
Figure 5-4.

d. Select COM1 (or the port that you used) in the Serial Port list box, 
then click on OK to save the setting and close the dialog box.

Note. If your data system computer has too few serial ports for your needs, 
you might need to install the 4-port serial PCB as discussed in Chapter 10: 
Connecting the 4-Port Serial PCB.

Figure 5-4. SN4000 Configuration dialog box
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6. Use the Xcalibur data system Instrument Configuration dialog box to 
assign the RS-232 connection from the UV6000LP to an empty COM 
port, such as COM3, of the data system computer:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the TSP UV6000 button. The TSP UV6000 button is copied to the 
Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the TSP UV6000 button in the Configured Devices 
group box. Xcalibur opens the UV6000 Configuration dialog box. 
See Figure 5-5.

d. Select the port to which the UV6000LP is attached (in this case 
COM3) in the Serial Port list box, then click on OK to save the setting 
and close the dialog box.

Go to the next section: Configuring the Autosampler and Pump.

Figure 5-5. UV6000 Configuration dialog box
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5.3 Configuring the Autosampler and 
Pump

To configure the autosampler and pump, proceed as follows:

1. Configure the autosampler for SpectraNet communication:

a. Turn on the pump, autosampler, and UV detector.

b. Turn on the SN4000.

c. After the autosampler power-up sequence is complete, press 
<MENU> on the autosampler keypad, then select 
/OPTIONS/Configurations/ to access the Configurations Menu.

d. Move the cursor to the Mode field, and use the <+> and the <−> keys 
to select SpectraNet. Then, press <ENTER> to accept the field value 
and exit the Configuration Menu.

2. Configure the autosampler for contact closure:

a. Press <MENU> on the autosampler keypad, then select 
/OPTIONS/Input Polarity/ to access the Input Polarity Menu.

b. Move the cursor to the Pump Ready Active field, and use the <+> and 
the <−> keys to select Hi or Lo. Both the autosampler and the pump 
must have the same polarity. Then, press <ENTER> to accept the 
field value and exit the Configuration Menu.

3. Configure the pump for contact closure:

a. Press <MENU> on the pump keypad, then select /OPTIONS/More/ 
to access the More Menu.

b. Move the cursor to the Ready Output Active field, and use the <+> 
and the <−> keys to select Hi or Lo. Both the autosampler and the 
pump must have the same polarity. Then press <ENTER> to accept 
the field value and exit the Configuration Menu.

4. Use the Xcalibur data system Instrument Configuration dialog box to 
configure the autosampler and pump:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the TSP Autosampler button. The TSP Autosampler button is copied 
to the Configured Devices group box and is displayed as a 
Configured Devices button.

c. Double-click on the TSP Autosampler button in the Configured 
Devices group box. Xcalibur opens the TSP Autosampler 
Configuration dialog box. See Figure 5-6.
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d. Click on Autoconfigure to configure the autosampler, and then 
click on OK to save the settings and close the dialog box.

e. Scroll through the Available Devices group box and double-click on 
the TSP P4000 (or TSP P2000) button. The TSP P4000 button is 
copied to the Configured Devices group box and is displayed as a 
Configured Devices button.

f. Double-click on the TSP P4000 button in the Configured Devices 
group box. Xcalibur opens the Pump Configuration dialog box. See 
Figure 5-7.

g. Click on Autoconfigure to configure the pump, and then click on 
OK to save the settings and close the dialog box.

Figure 5-6. Autosampler Configuration dialog box

Figure 5-7. Pump Configuration dialog box
_________________ Finnigan LTQ MS Detector Getting Connected ________________  5-11Thermo
ELECTRON CORPORATION





Chapter 6
Connecting the Agilent 1100 Series LC

The Xcalibur data system allows control of the Agilent®1 1100 Series LC. 

For additional information about the Agilent 1100 Series LC refer to the 
Agilent 1100 Series LC reference manuals.

Table 6-1 lists the Xcalibur supported firmware versions for the 
Agilent 1100 Series LC.

Table 6-1. Xcalibur supported firmware versions for the Agilent 1100 Series LC

*To obtain the firmware versions for the Agilent 1100 modules, verify that the Agilent 1100 Series modules are connected by CAN 
communication cables, all the modules are turned on, and the Agilent 1100 Control Module is connected. Push the <ESC> key on the 
Control Module until System is displayed in the upper left corner of the display, and then push the <F4> key to access the Records 
and display the firmware version.

**Only works with version B of the control module

1 Formerly Hewlett-Packard® (HP)

Module Model Number Firmware Version*

Isocratic pump G1310A 5.04

Binary pump G1312A 5.04

Quaternary pump G1311A 5.04

Capillary pump G1376A 5.05

Autosampler G1313A 5.04

Micro-sampler G1387A 5.04

Thermostatted autosampler G1329A 5.04

Well-plate autosampler G1367A 5.04

Micro well-plate auttosampler G1377A 5.04

Thermostatted column compartment G1316A 5.04

Variable wavelength detector G1314A 5.04

Diode-array detector G1315A 5.04

Multiple wavelength detector** G1365B 5.04
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Agilent 1100 Series LC systems with JetDirect® interface cards must have 
revision 2 mainboards to function properly with LAN communications.   
Table 6-2 shows the required revision level for each module; the serial 
number listed in the table and all serial numbers after that number are 
supported.

Connect the LTQ MS Detector to an Agilent 1100 Series LC as follows:

1. Interconnect the modules of your Agilent 1100 Series LC with the CAN 
cables following the instructions in the Agilent 1100 Series LC reference 
manuals.

2. Locate the 8-bit configuration switch (labeled CONFIG) on the rear of 
each Agilent 1100 Series module. Make sure that the third DIP switch is 
in the 0 position (down) to specify the use of the Ethernet interface. 

3. If your Agilent 1100 Series Autosampler is not equipped with an External 
Contact Interface PCB (P/N 00012-27714), you need to install the PCB:

a. Make sure that the autosampler is Off.

Table 6-2. Agilent 1100 modules with JetDirect Cards and the 
supported version serial number

Module P/N (Mainboard) Supported Version Serial 
Numbers*

* All serial numbers above the listed number in numeric order are supported.

G1310A 
Isocratic

G1311-65520 DE64300355
US64400233

G1311A 
Quad

G1311-65520 DE64301137
US64401134

G1312A 
Bin

G1312-65520 DE64300703
US64400425

G1313A 
ALS

G1313-65520 DE64302092
US64400886

G1314A 
VWD

G1314-65520 JP64201926
JP64201926

G1315A 
DAD

G131-65520 DE64301532
US64400333

Note. The Agilent 1100 Series devices query the PC for the stack IP address 
only during their start up procedure. Therefore, complete the following 
procedure and ensure that the Xcalibur Home Page window is open before 
turning on the Agilent 1100 Series devices.
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b. Remove the cover plate from the slot where you will install the 
External Contact Interface PCB by loosening the two screws that 
fasten the plate to the chassis of the autosampler.

c. Insert the External Contact Interface PCB into the slot and tighten the 
two screws to fasten the PCB to the chassis of the autosampler. See 
Figure 6-1.

4. Connect the 2-wire DB15 trigger cable (PCB P/N 00012-27716) from the 
LTQ MS Detector I/O panel to the RELAY CONTACT connector located 
on the External Contact Interface PCB of the Agilent 1100 Series 
Autosampler following the wiring scheme shown in Table 6-3. 
(Figure 6-1)

Table 6-3. Wiring the LTQ MS Detector and the Agilent 1100 Series 
Autosampler for contact closure

Figure 6-1. Agilent 1100 Series Autosampler (G1313A) rear panel

External Contact
Interface PCB RELAY CONTACT

  

REMOTE RS232 CAN CAN GPIB CONFIG

CAN Connectors GPIB Connector 8-Bit Configuration 
Switch

Cable Wire Agilent 1100 Series 
Autosampler Contact 

Closure Pin

LTQ MS Detector 
I/O Panel

White 1 Start In (+)

Brown 2 Start In (-)
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5. If you need to install the HP JetDirect 400N network card, do the 
following:

a. Make sure that the module is Off.

b. Remove the cover plate from the slot where you will install the HP 
JetDirect 400N network card by loosening the two screws that fasten 
the plate to the chassis of the module.

c. Insert the HP JetDirect 400N network card into the slot and tighten 
the two screws to fasten the PCB to the chassis of the module. 

6. Connect an Ethernet cable from the JetDirect 400N network card to the 
Ethernet hub.

7. Connect an Ethernet cable from the Ethernet hub to the Ethernet card in 
the computer that is dedicated to the LC system (typically Network 
Interface Card number 3).

8. Use the Xcalibur data system Instrument Configuration dialog box to 
assign contact closure control to the Agilent 1100 Series Autosampler:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the Agilent 1100 AS button. The Agilent 1100 AS button is copied to 
the Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the Agilent 1100 AS button in the Configured 
Devices group box. Xcalibur opens the Agilent 1100 Autosampler 
Configuration dialog box.

d. Click on the General tab to open the General page. See Figure 6-2.

Important. An HP JetDirect 400N network card must be installed in one 
module in the Agilent 1100 Series LC stack. If your LC stack contains a 
detector (e.g., diode-array detector, variable wavelength detector, multiple 
wavelength detector), the HP JetDirect 400N network card should be 
installed in the detector. Otherwise, it can be installed in any module with an 
open slot. 
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e. Select the Contact Board Installed check box.

f. In the Stack MAC address text box, enter the Media Access Control 
address for your Agilent LC stack. The stack MAC address is a 
unique identification for each network card. The manufacturer 
usually stamps it on the network card.

g. In the Stack IP Address list box, enter the IP address for your Agilent 
1100 LC stack. Contact your network administrator for the IP 
address.

h. In the Sub-mask text box, enter the subnet mask (address mask). 
Leave the subnet mask set to its default value, or contact your 
network administrator for the subnet mask.

i. In the Bootp Server text box, enter the IP address for the network card 
in your PC that is responsible for assigning the stack IP address for 
your Agilent 1100 LC system. Contact your network administrator for 
the BOOTP server IP address.

j. Click on OK to save the settings and close the dialog box.

Figure 6-2. Agilent Autosampler dialog box

Note. The TCP/IP settings are shared by all Agilent 1100 LC modules in the 
stack. Changing the value of a setting for one module in the Instrument 
Configuration dialog box changes the value of that setting for all modules in 
the stack.
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9. Use the Xcalibur data system Instrument Setup to select the Agilent 1100 
Series Autosampler contact closure terminal and trigger type:

a. Choose Start > Programs > Xcalibur > Xcalibur to open the 
Home Page. Then, click on the Instrument Setup button to open the 
Instrument Setup window.

b. Click on the Agilent 1100 AS button in the Instrument Setup viewbar 
on the left side of the window to open the Instrument Setup view. 
Then, click on the Timed Events tab to open the Timed Events page. 
See Figure 6-3.

c. Click on the Contact 1 text box to activate the list box. Then, select 
Closed in the list box.

d. Ensure that all of the other Contact text boxes display Open.

e. Select File > Exit to close the Instrument Setup window. Xcalibur 
prompts you with the Save As dialog box, the File Summary 
Information Dialog box, and the File Save – Audit Trail dialog box

.

10. Ensure that the Xcalibur Home Page is still open and power up the 
Agilent 1100 Series modules. 

11. Verify that the correct firmware is installed in the Agilent 1100 Series 
modules. (Refer to 6-1.)

12. Turn off the solvent tracking feature on the Agilent 1100 pump:

a. Close the Xcalibur Home Page.

b. Using the Agilent 1100 handheld control module, on the Analysis 
screen press the Settings button <F1>.

c. Press the number corresponding to the pump.

Figure 6-3. Instrument Setup window, showing the Agilent 1100 
Series Autosampler view with a portion of the Timed 
Events page displayed. The Timed Events page is for 
selecting the Agilent 1100 Series Autosampler contact 
closure terminal and contact closure trigger type.

Note. The solvent tracking feature on the Agilent 1100 LC pumps is not 
supported by Xcalibur at this time. This feature must be turned off to prevent 
error messages from terminating the data acquisition.
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d. Press the Bottle Fillings button <F4>.

e. Set all of the solvent Total boxes to 0. The solvent Actual boxes are 
then automatically set to 0.

f. Clear the Error If Empty check box by using the right arrow to move 
the focus to this setting and then pressing Enter.

g. Press the Done button <F6>.

13. Choose Start > Programs > Xcalibur > Xcalibur to open the Home 
Page. The Agilent 1100 devices should reconnect and appropriately 
display their status.
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Chapter 7
Upgrading the HP 1100 Series LC

The Xcalibur data system allows control of the Hewlett-Packard® (HP) 
1100 Series LC only if you upgrade the HP 1100 communication interface to 
an Ethernet interface. 

Upgrade your HP 1100 Series LC as follows:

1. Order the appropriate upgrade parts from your local office for 
Thermo Electron San Jose products:

• If the HP 1100 is not currently interfaced to a Finnigan mass 
spectrometer as an Xcalibur-controlled GPIB inlet device, order the 
kit listed below in Table 7-1.

Table 7-1. Xcalibur Kit to upgrade the HP 1100 Series LC

• If the HP 1100 is currently interfaced to a Finnigan mass spectrometer 
as an Xcalibur-controlled GPIB inlet device, order the parts listed 
below in Table 7-2.

Table 7-2. Parts to upgrade an Xcalibur-controlled HP 1100 
Series LC

Part Number Description of Kit

OPTON-30018 JetDirect Ethernet Control Kit
Contact closure PCB
External contact closure cable
Ethernet 10 Base-T cable (2)
10/100 Autosensing 8-port Ethernet switch
HP JetDirect 400N PCB

Part Number Description of Part

00825-01140 HP JetDirect 400N PCB

00012-70008 Ethernet 10 Base-T cable (2)

Note. An HP 1100 LC system that is currently interfaced to a Finnigan mass 
spectrometer as an Xcalibur-controlled GPIB inlet device already should 
have installed the contact closure PCB and the external contact closure 
cable. Therefore, you need to order only the parts specified in Table 7-2.
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2. Follow the instructions in Chapter 6: Connecting the Agilent 1100 
Series LC to install the JetDirect 400N PCB.

3. Continue to follow the instructions in Chapter 6: Connecting the 
Agilent 1100 Series LC to connect the LTQ MS Detector to the system. 

Note. After the communication interface in the HP 1100 LC system is 
upgraded to an Ethernet interface, the system is the same as, and will be 
referred to as, an Agilent 1100 LC system.
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Chapter 8
Connecting the Waters LC

The Xcalibur data system allows control of the Waters Alliance® and 
Alliance HT Separations Modules.

This chapter contains the following sections:

• Connecting to the Waters Alliance or the Alliance HT Separations 
Module

• Connecting to the Waters 2487 Dual λ Absorbance Detector

Table 8-1 lists the Xcalibur kits used with the Waters LC.

Table 8-1.  Xcalibur kits used with the Waters LC

Part Number Description of Kit

OPTON-21710 Xcalibur Waters Interface Kit
Waters serial I/F cable
2-wire trigger cable (contact closure)

OPTON-21721 Xcalibur SS420x Interface Kit
SS420x PCB 
serial cable
2-wire trigger cable (contact closure) 
power supply
Xcalibur Additional 4-Port Serial Kit
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8.1 Connecting to the Waters Alliance 
or the Alliance HT Separations 
Module 

Table 6-2 lists the Xcalibur supported firmware version for the Waters 
Alliance and Alliance HT Separations Modules.

Table 8-2. Xcalibur supported firmware version for the Waters 
Alliance and Alliance HT Separations Modules

*To obtain the firmware version for the Waters Separations Module, turn on the instrument and 
watch the front panel display as the instrument cycles through the system startup.

For additional information about the Waters Alliance or Alliance HT 
Separations Module, refer to the operator’s guide that came with your Waters 
HPLC system.

To connect the LTQ MS Detector to a Waters Alliance or Alliance HT 
Separations Module, proceed as follows. See Figure 8-1.

1. Connect the serial cable (P/N 00012-51086) from the RS-232 connector 
(labeled B) located on the rear of the Waters Alliance or Alliance HT 
Separations Module to an available RS-232 connector located on the rear 
of the data system computer. 

2. Connect the 2-wire trigger cable (in kit P/N OPTON-21710) from the 
LTQ MS Detector power entry module to the contact closure terminal 
(labeled B) located on the rear of the Waters Alliance or Alliance HT 
Separations Module following the wiring scheme shown in Table 8-3.

Module Model Number Firmware Version*

Separations module 2690 1.22

Separations module 2695 2.02

High throughput separations 
module

2795 2.02
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.

Table 8-3. Wiring the LTQ MS Detector and the Waters Alliance or Alliance HT Separations 
Module for contact closure

3. Set the Waters Alliance or Alliance HT Separations Module RS-232 
communication to ASCII:

a. From the Main page on the instrument display, press the <Config> 
key to open the Configuration page.

b. Use the <  > key to select the Controlled via RS-232 option in the 
System group box. Then press the <Enter> key to open the list box.

c. Use the <  > and <  > keys to select Controlled by RS-232 
(ASCII) in the list box. Then press the <Enter> key to save the 
change.

d. Press the <Exit> key to return to the Main page.

4. Use the Xcalibur data system Instrument Configuration dialog box to 
assign the RS-232 connection from the Waters Alliance or Alliance HT 
Separations Module to the port selected in step 1, such as COM1 (port A), 
of the data system computer:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

Figure 8-1. Waters Alliance or Alliance HT Separations Module rear 
panel contact closure terminals

Pin 1
Pin 2

Contact Closure 
Terminal B

B A

RS232

Waters Alliance or Alliance HT Separations Module
Contact Closure Terminal B

LTQ MS Detector Power Entry 
Module

pin 1 Start In +

pin 2 Start In ground
_________________ Finnigan LTQ MS Detector Getting Connected _________________  8-3Thermo
ELECTRON CORPORATION



Connecting the Waters LC
Connecting to the Waters Alliance or the Alliance HT Separations Module__________________Finnigan LTQ
b. Scroll through the Available Devices group box and double-click on 
the appropriate button for your device (Waters 2690/2695 or 
Waters 2795). The button is copied to the Configured Devices group 
box and is displayed as a Configured Devices button.

c. In the Configured Devices group box, double-click on the button for 
your device.

• If you double-click on the Waters 2690/2695 button, Xcalibur 
opens the Alliance 2690/2695 Configuration dialog box. See 
Figure 8-2.

• If you double-click on the Waters 2795 button, Xcalibur opens 
the Alliance 2795 Configuration dialog box. See Figure 8-3.

d. Confirm that the Port list box in the RS-232 Configuration group box 
is set to the port that you selected in step 1.

• If you have a Waters Alliance 2690 or Alliance 2695 Separations 
Module, skip to step 4.f.

• If you have a Waters Alliance HT 2795 Separations Module, continue 
with the next step.

e. In the Carrier Plate group boxes, specify the tray type that you are 
using and the sequential reference counting order for each plate.

f. Click on Autoconfigure, then click on OK to save the settings and 
close the dialog box.

Figure 8-2. Alliance 2690/2695 Configuration dialog box
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Figure 8-3. Alliance 2795 Configuration dialog box
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8.2 Connecting to the Waters 2487 
Dual λ Absorbance Detector

If your Waters LC system is equipped with a Waters 2487 Dual λ Absorbance 
Detector and you want to record analog output from the detector, you need to 
connect the SS420x to the data system computer.

For instructions on how to install and configure the SS420x refer to 
Chapter 9: Connecting the SS420x Analog-to-Digital Interface Kit.

Connect the Waters 2487 Dual λ Absorbance Detector to the SS420x as 
follows: 

Connect the 2-wire signal cable (in kit P/N OPTON-21710) from the terminal 
(labeled B) located on the rear of the Waters 2487 Dual λ Absorbance 
Detector to the bus terminal located on the SS420x terminal panel interface. 
Follow the wiring scheme shown in 8-4.

Table 8-4. Wiring connection for the Waters 2487 Dual λ Absorbance Detector and the 
SS420x terminal panel

Note. Xcalibur 1.4 supports the Waters 2487 Dual λ Absorbance Detector 
only when it is used in conjunction with the Waters Alliance 2690 or 2695 
Separations Module.

Waters 2487 Dual λ Absorbance Detector
Terminal B

SS420x Terminal Panel
(use any channel 1 to 4)

Pin 1 CH +

Pin 3 CH -

Note. Confirm that the Waters 2487 Dual λ Absorbance Detector is 
connected to the Waters Alliance 2690 or 2695 Separations Module with the 
GPIB cable that was supplied with your LC system. Turn on the detector 
before you turn on the Waters Alliance 2690 or 2695 Separations Module.
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Chapter 9
 Connecting the SS420x

Analog-to-Digital Interface Kit

The SS420x offers four independent (20-bit resolution) analog-to-digital 
(A/D) converters for data acquisition from devices that are not currently 
controlled by Xcalibur. Additionally, there are four inputs and eight outputs 
that provide contact closure control for devices that are not currently 
controlled by Xcalibur. For this chapter, contact closure refers to open 
collector, TTL logic, or relay closure.

Xcalibur can support up to four SS420x units; however, only one unit can be 
used at a time.

This chapter contains the following sections:

• Connecting and configuring the SS420x

• Configuring the SS420x for data acquisition and control of external 
devices

Table 9-1 lists the Xcalibur kit used with the SS420x.

Table 9-1. Xcalibur Kit used with the SS420x

Part Number Description of Kit

OPTON-21721 Xcalibur SS420x Interface Kit
SS420x
serial cable
2-wire trigger cable (contact closure) 
power supply
Xcalibur Additional 4-Port Serial Kit
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9.1 Connecting and Configuring the 
SS420x

Connect the SS420x to the data system computer and configure it for the 
Xcalibur data system as follows:

1. Turn off the data system computer.

2. Connect the serial cable to the RS-232 port on the rear of the SS420x. 

3. Connect the other end of the serial cable to the RS-232 port located on the 
rear of the data system computer. Be sure to use only ports 1 through 4 to 
connect the SS420x.

4. Connect the power cable from the 9 V dc power supply included with the 
SS420x to the POWER inlet located on the rear of the SS420x. 

5. Restart the data system computer.

6. Verify that the SS420x is configured for Xcalibur data system control:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the SSI SS420x A/D Converter button. The SSI SS420x A/D 
Converter button is copied to the Configured Devices group box and 
is displayed as a Configured Devices button.

c. Double-click on the SSI SS420x A/D Converter button in the 
Configured Devices group box. Xcalibur opens the SS420x 
Configuration dialog box.

d. Select the COM port to which the device is attached. 

e. Click on OK to save the changes and close the SS420x Configuration 
dialog box.

f. Click on Done to close the Instrument Configuration dialog box.
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9.2 Configuring the SS420x for Data 
Acquisition and Control of 
External Events

The SS420x has two functions as described in the following topics: 

• Data acquisition from analog devices

• Control of external events

Data Acquisition from Analog Devices
The SS420x has four channels on the analog-to-digital converter (Channel A 
to Channel D) that allow for data input from analog devices not currently 
controlled by Xcalibur. 

To acquire data from an analog device, the following connections are 
required: 

• A 2-wire signal cable from each analog device to the SS420x 

• A 2-wire trigger cable from the analog device(s) to the LC autosampler

• A 2-wire trigger cable (contact closure) from the LC autosampler to the 
SS420x

• A 2-wire trigger cable (contact closure) from the LC autosampler to the 
LTQ MS detector

Connect the cables and configure the SS420x as follows. See Figure 9-1.

1. Connect the 2-wire signal cable from the SS420x to the analog device. 
Follow the wiring scheme shown in Table 9-2. If you want to connect 
more than one analog device to the SS420x, use a separate channel 
(Channel A to Channel D) for each device.

Note. The following procedure is a general procedure for connecting up to 
four analog devices to the SS420x. Your particular application might require 
a different procedure or a different configuration of devices.

Note. Figure 9-1 shows how to connect the maximum of four analog devices 
to the SS420x. Your particular application might require a different 
configuration of devices or a different wiring scheme.
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Table 9-2. Wiring an analog device and the SS420x for A/D data 
acquisition

SS420x
Analog Inputs

Analog Device
(0 to 1 V or 0 to 10 V Output)

CH1 + Signal output pin

CH1 - Ground pin

Figure 9-1. Wiring diagram showing four analog devices connected to the SS420x and 
autosampler. Each analog device is connected with a 2-wire signal cable and 2-wire 
trigger cable (contact closure). 

2-Wire Signal Cable

2-Wire Trigger Cable

Computer

Autosampler

Analog Device 

1

Analog Device 

2

Analog Device 

3

Analog Device 

4

SS420x

LTQ MS Detector

Thinwire Ethernet Cable

2-Wire Trigger Cables

2-Wire  

Signal Cables
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2. Connect a 2-wire trigger cable from the analog device to the LC 
autosampler. Follow the wiring scheme shown in Table 9-3.

Table 9-3. Wiring the LC autosampler and the analog device for 
contact closure

3. Connect a 2-wire trigger cable from the LC autosampler to the SS420x. 
Follow the wiring scheme shown in Table 9-4.

Table 9-4. Wiring the LC autosampler and the SS420x for contact 
closure 

4. Connect a 2-wire trigger cable from the LC autosampler to the LTQ MS 
detector. Follow the wiring scheme shown in Table 9-5.

Table 9-5. Wiring the LC autosampler and the LTQ MS detector for 
contact closure 

5. Configure the SS420x for data acquisition:

a. Choose Start > Programs > Xcalibur > Xcalibur to open the 
Xcalibur data system Home Page. Then, click on the Instrument 
Setup button to open the Instrument Setup window.

b. Click on the SSI SS420x A/D Converter button to open the SS420x 
Instrument Setup view with the Acquisition page displayed. 
See Figure 9-2.

c. Select 1 in the Number of Channels In Use spin box. (If more than 
one channel is to be used, select the appropriate number of channels.)

d. Select the data acquisition rate in the Frequency list box.

Analog Device LC autosampler

Start in pin Inject out pin

Ground pin Ground pin

LC autosampler SS420x 
(START1 to START4)

Inject out pin START1 + 

Ground pin GND1 − 

LC autosampler LTQ MS detector 
Inputs

Inject out pin START IN +

Ground pin START IN  ground pin
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Figure 9-2. Instrument Setup window, showing the SS420x view with the Acquisition page 
displayed 
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e. In the Channel A text box enter the name of the analog device. (If 
more than one channel is to be used, enter the name of each device in 
the appropriate channel text box.)

f. The acquisition of data through the SS420x can be stopped by either 
an Xcalibur-controlled device or after a specified time: 

• In the Acquisition Time group box, select the Run Until The 
Device Ends option button if you want a device to stop the 
SS420x data acquisition. In the Run Until The Device Ends list 
box, select the device that will signal the stop of data acquisition.

or

• In the Acquisition Time group box, select the Specify Time 
option button if you want the SS420x to stop data acquisition 
after a specified time. In the Specify Time spin box, enter the 
acquisition time.

6. Click on the Configuration tab to open the Configuration page. 
See Figure 9-3. Then, setup the SS420x: 

a. Confirm that the appropriate Channel (Channel A to Channel D) 
Range is selected from the range list box:

• 0 - 1 V, if the output signal from the analog device is between 
-1 and +1 V

• 0 - 10 V, if the output signal from the analog device is between 
-10 and +10 V

b. Select Trig 1 in the Trigger Input list box. If you want to use a device 
other than the LC autosampler to start data acquisition, select the 
appropriate trigger line that is connected to the device.

c. Select Closed Contact in the Trigger On Contact list box or refer to 
the analog device reference manual to determine the trigger type 
setting.

Note. The analog device can be triggered by either a closed contact or open 
contact signal. Refer to the reference manual that is supplied with your 
device to determine its trigger type.
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.

Figure 9-3. Instrument Setup window, showing the SS420x view with 
the Configuration page displayed 

Note. In the Configuration dialog box, the values that appear in the 
Calibration group box are set by the manufacturer to ensure proper 
performance of the A/D converter.

Note. After you have set up your sequence and loaded the autosampler with 
your samples, open the Run Sequence dialog box and verify that no 
instrument is selected as a Start Instrument. Start the run and watch the 
Home Page - Status View (choose View > Status View) until both the 
SS420x and LTQ MS detector display Wait for Contact Closure. Then, 
manually start the autosampler.
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Control of External Events
The SS420x has eight digital outputs (labeled RLY1 to RLY8) that can be used 
to control devices that are not currently controlled by Xcalibur. 

To connect an external device to the SS420x and to configure the SS420x, 
proceed as follows:

1. Connect a 2-wire trigger cable from input terminals of the external device 
to the SS420x. Follow the wiring scheme shown in Table 9-6.

Table 9-6. Wiring an external device and the SS420x for contact 
closure

2. Configure the SS420x to control an external device:

a. Choose Start > Programs > Xcalibur > Xcalibur to open the 
Xcalibur data system Home Page. Then, click on the Instrument 
Setup button to open the Instrument Setup window.

b. Click on the SSI SS420x A/D Converter button to open the SS420x 
view with the Acquisition page displayed. See Figure 9-2. Then, click 
on the External Events tab to open the External Events page. See 
Figure 9-4.

Note. External devices can be triggered by either a closed contact or open 
contact signal. Refer to the reference manual that is supplied with your 
external device to determine its trigger type.

External Device
SS420x

(RLY1 to RLY8)

Input pin RLY A 

Ground pin RLY B
_________________ Finnigan LTQ MS Detector Getting Connected _________________  9-9Thermo
ELECTRON CORPORATION



Connecting the SS420x Analog-to-Digital Interface Kit
Configuring the SS420x for Data Acquisition and Control of External Events ________________Finnigan LTQ
c. In the Events Description group box select the number of events you 
want to control in the Number of Events spin box. You can control up 
to 50 events.

d. In the Description text box, enter a description of the multi-event 
procedure you want to run.

e. Set up an event in the Event Setup group box:

i. In the Event 1 row, enter a description of the first event in the 
Descriptions text box.

ii. Enter a delay time for the event in the Delay Time text box. The 
delay time determines when an event occurs. The delay time 
equals zero when the SS420x starts acquisition or the LTQ MS 
detector sends a contact closure signal.

Figure 9-4. Instrument Setup window, showing the SS420x view with 
the External Events page displayed. In this example the 
SS420x controls three devices. The three devices are 
Trigger Type - Closed Contact
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iii. Select the digital output terminal that you want to trigger: 

• For a Trigger Type - Closed Contact device:
When the Digital Output In Use check box is selected, the 
external device receives a closed contact signal at the specified 
delay time. When the Digital Output In Use check box is not 
selected, the external device receives an open contact signal at the 
specified delay time.

or

• For a Trigger Type - Open Contact device:
When the Digital Output In Use check box is selected, the 
external device receives an open contact signal at the specified 
delay time. When the Digital Output In Use check box is not 
selected, the external device receives a closed contact signal at 
the specified delay time.

iv. Repeat steps i-iii for the next event.

Figure 9-4 shows an example of the SS420x controlling three external devices 
with five events over a period of 4 hours (14400 seconds). For this example 
all devices are Trigger Type - Closed Contact. When a closed contact event 
occurs, the external device turns on and performs its function. When the open 
contact event occurs, the external device turns off and ceases its function. 
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Chapter 10
Connecting the 4-Port Serial PCB

The 4-Port Serial PCB and Quad DB9 male cable (P/N OPTON-21709) 
provide four additional communication ports for the data system computer. 
See Figure 10-1.

Table 10-1 lists the Xcalibur kit used with the 4-Port Serial PCB.

Table 10-1. Xcalibur Kit used with the 4-Port Serial PCB

Part number Description of kit

OPTON-21709 Xcalibur Additional 4-Port Serial Kit
4-Port Serial PCB (PCI) and software
Quad DB (male adapter)

Figure 10-1. 4-Port Serial PCB and Quad DB9 male cable

4-Port Serial PCB

Quad DB9 Male Cable
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To install the 4-Port Serial PCB in the data system computer, proceed as 
follows:

1. Turn off the data system computer.

2. Remove the computer cover to expose the PCBs.

3. Remove the cover plate from the computer slot where you want to install 
the 4-Port Serial PCB.

4. Carefully remove the 4-Port Serial PCB from its protective shipping bag. 
Wear a grounding strap to avoid damaging the 4-Port Serial PCB.

5. Hold the 4-Port Serial PCB by its edges and position it so that the 78-pin 
connector faces the rear of the computer.

6. Plug the 4-Port Serial PCB into the slot of the computer by firmly pushing 
the edge of the card into the connector until the card is seated.

7. Use the screw from the slot cover plate to secure the 4-Port Serial PCB in 
place.

8. Replace the computer cover.

9. Connect the Quad DB9 male cable to the connector located on the 4-Port 
Serial PCB. Connect the other end of the cable to the appropriate inlet 
device.

10. Restart the data system computer.

The 4-Port Serial PCB is a Plug and Play device. When Windows® XP starts, 
it automatically detects and configures the new 4-Port Serial PCB and then 
loads the appropriate drivers.

Caution. Wear a grounding strap to avoid damaging the 4-Port Serial PCB.
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Chapter 11
Making Plumbing Connections to Run

Samples on the LTQ MS detector

This chapter describes how to make plumbing connections to run samples on 
the LTQ MS detector.

The following topics are discussed in this chapter:

• Plumbing connections for ESI/MS

• Plumbing connections for APCI/MS

Table 11-1 summarizes the sample introduction and analytical techniques for 
ESI/MS and APCI/MS.

Table 11-2 lists the frequently used parts for making plumbing connections 
for ESI/MS and APCI/MS.

Table 11-1. Sample introduction and analytical techniques for ESI/MS and APCI/MS

Sample Introduction to 
LTQ Mass Spectrometer

ESI Analytical Technique APCI Analytical Technique

Syringe pump
ESI/MS (Figure 11-1, page 11-6)

Analysis of a pure analyte 
Automatic calibration and 
tuning

Syringe pump injection into LC 
solvent flow
ESI/MS (Figure 11-2, page 11-7) 
APCI/MS (Figure 11-6, page 11-12)

Analysis of a pure analyte Analysis of a pure analyte

Loop injection into LC solvent flow
ESI/MS (Figure 11-3, page 11-8)
ESI/MS (Figure 11-5, page 11-10)
APCI/MS (Figure 11-7, page 11-13)

Analysis of a pure analyte 
Automatic optimization of 
tuning using an analyte

Analysis of a pure analyte 
Automatic optimization of tuning 
using an analyte

Autosampler without chromatographic 
separation
ESI/MS (Figure 11-4, page 11-9)
APCI/MS (Figure 11-8, page 11-14)

Analysis of one or more pure 
analytes

Analysis of one or more pure 
analytes

Autosampler with chromatographic 
separation
ESI/MS (Figure 11-4, page 11-9)
APCI/MS (Figure 11-8, page 11-14)

Analysis of a mixture Analysis of a mixture
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Table 11-2. Frequently used parts for making plumbing connections for ESI/MS and APCI/MS

Part Part Description Part Number

Metal Needle Kit
(contains a blunt-tip, 32-gauge stainless steel needle; ferrules; 
PEEK™ adapter union; and ZDV 1/4-28 union)

OPTON-20014

Metal Needle Kit
(contains a blunt-tip, 34-gauge stainless steel needle; ferrules; 
PEEK adapter union; and ZDV 1/4-28 union)

OPTON-20015

Tubing, fused-silica, 0.1 mm ID x 0.4 mm OD
(infusion line)

00106-10504

Tubing, fused-silica, 0.1 mm ID x 0.190 mm OD
(fused-silica sample tube and fused-silica capillary tube)

00106-10499

Tubing, PEEK, 0.005 in. ID x 1/16 in. OD (red) 00301-22912

Tube, Teflon, 0.03 in. ID x 1/16 in. OD
(for use with syringe needle and LC union)

00301-22915

Tubing, PVC, unreinforced, 3/8 in. ID (clear)
(API probe drain tube)

00301-22895

Fitting, Adapter, Kel-F, Upchurch Scientific (connects directly to ESI 
probe inlet)

00101-18080

Fitting, Fingertight, Upchurch Scientific (brown)
(used with (red) PEEK tubing)

00101-18081

Ferrule, Kel-F, 0.008 in. ID, Upchurch Scientific (clear)
(used with fused-silica tubing and the blunt-tip, 34-gauge stainless 
steel needle included in Metal Needle Kit)

00101-18114

Ferrule, Kel-F, 0.012 in. ID, Upchurch Scientific (clear)
(used with blunt-tip, 32-gauge stainless steel needle included in 
Metal Needle Kit)

00101-18116

Ferrule, 0.016 in. ID, PEEK, Upchurch Scientific (brown)
(for use with fused-silica infusion line)

00101-18120

Ferrule, LC, 1/16 in., stainless steel, Valco
(used to connect the (red) PEEK tubing and the sample loop to the 
divert/inject valve)

00101-18122

Fitting, grounding union, 1/16 in. orifice, stainless steel 00101-18182

Fitting, Fingertight, Upchurch Scientific (red)
(used with (red) PEEK tubing)

00101-18195

Ferrule, Fingertight 2, Upchurch Scientific (brown)
(used with the Teflon tubing and (red) PEEK tubing)

00101-18196
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Fitting, LC union, 0.010 in. orifice, PEEK (black) 00101-18202

Fitting, LC TEE union, 0.020 in. orifice, PEEK (black) 00101-18204

Fitting, adapter union, PEEK, Upchurch Scientific (brown)
(used with blunt-tip 32 or 34-gauge stainless steel needle, included 
in Metal Needle Kit) 

00101-18206

Nut, LC 1/16 in. stainless steel, Rheodyne 2522-0066

Ferrule, LC 1/16 in. stainless steel, Rheodyne
(used to connect the (red) PEEK tubing and the sample loop to the 
divert/inject valve)

2522-3830

5 µL sample loop, stainless steel, Rheodyne 00110-22026

10 µL sample loop, stainless steel, Rheodyne 00110-22012

20 µL sample loop, stainless steel, Rheodyne 00110-22028

50 µL sample loop, stainless steel, Rheodyne 00110-22016

100 µL sample loop, stainless steel, Rheodyne 00110-22018

500 µL sample loop, stainless steel, Rheodyne 00110-22020

1 mL sample loop, stainless steel, Rheodyne 00110-22022

Table 11-2. Frequently used parts for making plumbing connections for ESI/MS and APCI/MS

Part Part Description Part Number
_________________ Finnigan LTQ MS Detector Getting Connected ________________  11-3Thermo
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Plumbing Connections for ESI/MS_______________________________________________Finnigan LTQ
11.1 Plumbing Connections for ESI/MS
You can fit the ESI probe with either a fused-silica sample tube or an optional 
blunt-tip, 32- or 34-gauge stainless steel needle. The 0.100 mm ID × 0.190 
mm OD fused-silica sample tube (P/N 00106-10499) is supplied in the 
standard Accessory Kit (P/N 97055-62003). The blunt-tip, 32-gauge stainless 
steel needle (P/N 97055-20217) is supplied in the optional Metal Needle Kit 
(P/N OPTON-20014). The blunt-tip, 34-gauge stainless steel needle (P/N 
97055-20220) is supplied in the optional Metal Needle Kit 
(P/N OPTON-20015).

There are several operating conditions in which you might choose to use the 
stainless steel needle rather than the fused-silica sample tube.

These include the following:

• When you are analyzing compounds with polar functional groups, some 
of the compounds might show improved ionization efficiency, especially 
acidic compounds in negative ion electrospray mode.

• Operation at very low flow rates in pure electrospray mode (i.e., with 
sheath and auxiliary gases turned off). Using a smaller internal diameter 
needle or fused-silica capillary produces smaller droplets, which might 
improve signal and stability at flow rates from 3 µL/min to 200 nL/min.

• Operation with acetonitrile in the mobile phase. Acetonitrile can cause 
elongation of the polyimide coating on the fused-silica capillary, which 
can degrade signal and signal stability over time. The stainless steel 
needle is not affected by acetonitrile.

The procedures for installing the blunt-tip stainless steel needles and for 
connecting the fused-silica capillary tube, with safety sleeve, to the ESI probe 
are described in the Finnigan Ion Max API Source Hardware Manual.
Thermo
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Plumbing Connection Diagrams for ESI/MS
The following ESI/MS plumbing diagrams are shown on pages 11-6 to 
11-10.

The following ESI/MS plumbing diagrams are shown in this topic:

• Figure 11-1. Plumbing diagram showing ESI/MS sample introduction 
from the syringe pump

• Figure 11-2. Plumbing diagram showing ESI/MS sample introduction 
from the syringe pump connected via an LC TEE union into the solvent 
flow from an LC

• Figure 11-3. Plumbing diagram showing ESI/MS sample introduction by 
loop injection into the solvent flow from an LC

• Figure 11-4. Plumbing diagram showing ESI/MS sample introduction 
from an LC autosampler with or without chromatographic separation

• Figure 11-5. Plumbing diagram showing ESI/MS sample introduction by 
loop injection into the solvent flow from an LC
_________________ Finnigan LTQ MS Detector Getting Connected ________________  11-5Thermo
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Drain to Waste Container:  Prevent solvent waste from

backing up into the API source and into the mass

spectrometer.  Always ensure that the drain hose is 

above the liquid level in the waste container.
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ESI Operation:  The ESI probe can be fitted

with either the fused-silica tube or with the 

blunt-tip, 32- or 34-gauge stainless steel 

needle.  For installation instructions refer to

the following topics in this manual:

Connecting the Fused-Silica Sample Tube

to the ESI Probe

or

Installing the Blunt-tip, 32- or 34-Gauge

Stainless Steel Needle and Connecting the

Fused-Silica Capillary Tube to the ESI Probe
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Figure 11-1. Plumbing diagram showing ESI/MS sample introduction from the syringe pump
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ted via an LC TEE union into the solvent flow from an LC

Drain to Waste Container:  Prevent solvent waste from

backing up into the API source and into the mass

spectrometer.  Always ensure that the drain hose is 

above the liquid level in the waste container.
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ESI Operation:  The ESI probe can be fitted

with either the fused-silica tube or with the 

blunt-tip, 32- or 34-gauge stainless steel 

needle.  For installation instructions refer to

the following topics in this manual:

Connecting the Fused-Silica Sample Tube

to the ESI Probe

or

Installing the Blunt-tip, 32- or 34-Gauge

Stainless Steel Needle and Connecting the

Fused-Silica Capillary Tube to the ESI Probe
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Figure 11-2. Plumbing diagram showing ESI/MS sample introduction from the syringe pump connec

To LC Union

Fingertight

Fittings

(00101-18081)

Stainless Steel

Ferrule

(2522-3830)

Infusion Line

Fused-Silica Capillary

(00106-10504)

Ferrules

(00101-18196)

Ferrules

(00101-18120)

Stainless

Steel Nut

(2522-0066)

Fingertight

Fitting

(00101-18195)



Making Plumbing Connections to Run Samples on the TSQ Quantum Ultra
Plumbing Connections for ESI/MS_____________________________________________________________________________________________________________________________________________________________________________ Finnigan LTQ

Thermo
ELECTRON CORPORATIONantum Ultra Getting Connected  _______________________________________________________________________________

nt flow from an LC

Drain to Waste Container:  Prevent solvent waste from

backing up into the API source and into the mass

spectrometer.  Always ensure that the drain hose is 

above the liquid level in the waste container.
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ESI Operation:  The ESI probe can be fitted

with either the fused-silica tube or with the 

blunt-tip, 32- or 34-gauge stainless steel 

needle.  For installation instructions refer to

the following topics in this manual:

Connecting the Fused-Silica Sample Tube

to the ESI Probe

or

Installing the Blunt-tip, 32- or 34-Gauge

Stainless Steel Needle and Connecting the

Fused-Silica Capillary Tube to the ESI Probe
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Figure 11-3. Plumbing diagram showing ESI/MS sample introduction by loop injection into the solve

Grounding

Union

Fingertight Fitting

(00101-18081)

Fused-Silica Capillary

Infusion Line

(00106-10504) 

LC Union

(00101-18202)
Ferrules

(00101-18120)

Fingertight Fitting

(00101-18195)



Making Plumbing Connections to Run Samples on the TSQ Quantum Ultra
Finnigan LTQ _____________________________________________________________________________________________________________________________________________________________________________Plumbing Connections for ESI/MS

Finnigan TSQ Quantum Ultra Getting Connected ____________________________________________________________________________ 11-9

r without chromatographic separation

Drain to Waste Container:  Prevent solvent waste from

backing up into the API source and into the mass

spectrometer.  Always ensure that the drain hose is 

above the liquid level in the waste container.
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ESI Operation:  The ESI probe can be fitted

with either the fused-silica tube or with the 

blunt-tip, 32- or 34-gauge stainless steel 

needle.  For installation instructions refer to

the following topics in this manual:

Connecting the Fused-Silica Sample Tube

to the ESI Probe

or

Installing the Blunt-tip, 32- or 34-Gauge

Stainless Steel Needle and Connecting the

Fused-Silica Capillary Tube to the ESI Probe
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Figure 11-4. Plumbing diagram showing ESI/MS sample introduction from an LC autosampler with o
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Drain to Waste Container:  Prevent solvent waste from

backing up into the API source and into the mass

spectrometer.  Always ensure that the drain hose is 

above the liquid level in the waste container.
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ESI Operation:  The ESI probe can be fitted

with either the fused-silica tube or with the 

blunt-tip, 32- or 34-gauge stainless steel 

needle.  For installation instructions refer to

the following topics in this manual:

Connecting the Fused-Silica Sample Tube

to the ESI Probe

or

Installing the Blunt-tip, 32- or 34-Gauge

Stainless Steel Needle and Connecting the

Fused-Silica Capillary Tube to the ESI Probe
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Figure 11-5. Plumbing diagram showing ESI/MS sample introduction by loop injection into the solve
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11.2  Plumbing Connections for 
APCI/MS

If you need to install or replace the APCI source probe components, refer to 
the instructions in the Finnigan Ion Max API Source Hardware Manual.

The following APCI/MS plumbing diagrams are shown on pages 11-12 to 
11-14:

• Figure 11-6. Plumbing diagram showing APCI/MS sample introduction 
from the syringe pump connected via an LC TEE into the solvent flow 
from an LC 

• Figure 11-7. Plumbing diagram showing APCI/MS sample introduction 
by loop injection into the solvent flow from an LC

• Figure 11-8. Plumbing diagram showing APCI/MS sample introduction 
from an LC autosampler with or without chromatographic separation
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Figure 11-6. Plumbing diagram showing APCI/MS sample introduction from the syringe pump conn
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vent flow from an LC

Drain to Waste Container:  Prevent solvent waste from
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Figure 11-7. Plumbing diagram showing APCI/MS sample introduction by loop injection into the sol
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 or without chromatographic separation

Drain to Waste Container:  Prevent solvent waste from
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spectrometer.  Always ensure that the drain hose is 

above the liquid level in the waste container.

1

2
3

4

5

From LC

To Ion Source

To Waste

Plug 

(optional)
11-14__________________________________________________________________________________ Finnigan

Figure 11-8. Plumbing diagram showing APCI/MS sample introduction from an LC autosampler with
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#
2-wire trigger (contact closure), connection for

Agilent 1100 Series Autosampler (table), 6-3
inlet devices not supported by Xcalibur (table), 3-4
terminal panel interface (table), 9-5
Waters Alliance Separations Modules (table), 8-3

4-Port Serial PCB, 10-1
figure, 10-1
installing, 10-2

A
Agilent 1100 Series LC

autosampler rear panel (figure), 6-3
firmware (table), 6-1
TCP/IP addresses (figure), 6-5
Timed Events page (figure), 6-6

analytical techniques
ESI/MS and APCI/MS (table), 11-1

APCI/MS
plumbing connections, 11-11

C
cable diagrams

SpectraSYSTEM LC
equipped with UV2000, 5-4
equipped with UV6000LP, 5-7

Surveyor LC System, 4-5, 4-6
cables

Ethernet, 1-6
Cautions

CMOS maximum voltage, 3-2
SN4000 power supply, 5-3, 5-6
solvent waste backing into API source, 2-2, 2-3
venting APCI source, 2-3
venting ESI source, 2-2

configuring
Agilent 1100 Series Autosampler, 6-4
SN4000 (figure), 5-5, 5-8
SpectraSYSTEM autosampler, 5-10
SpectraSYSTEM pump, 5-10
Waters Separations Modules, 8-3

connecting
4-Port Serial PCB, 10-1
SS420x, 9-1

Contact Closure Wiring Harness, 5-3

E
ESI/MS

plumbing connections, 11-4
Ethernet cards

configuring, 4-4
data system computer, 4-4
for upgrading HP 1100 LC, 7-1

F
Figures

4-port serial PCB, 10-1
Agilent 1100 LC

autosampler rear panel, 6-3
TCP/IP addresses (figure), 6-5
Timed Events page, 6-6

cable diagram, Surveyor LC System, 4-6
contact closure, 3-2
plumbing diagram for APCI/MS

from LC autosampler, 11-14
LC TEE, 11-12
loop injection, 11-13

plumbing diagram for ESI/MS
auto loop Injection, 11-10
LC flow, 11-9
LC TEE, 11-7
loop injection, 11-8
syringe pump, 11-6

Run Sequence dialog box, 3-5
SN4000 Configuration dialog box, 5-5
SpectraSYSTEM

Pump Configuration dialog box, 5-11
UV2000, cable connections, 5-4
UV6000 Configuration dialog box, 5-9
UV6000LP cable connections, 5-7

SS420x
Acquisition page, 9-6
Configuration page, 9-8
External Events page, 9-10
wiring diagram, 9-4

Waters
Configuration dialog box, 8-4, 8-5
contact closure terminals, 8-3

firmware
Agilent 1100 Series LC (table), 6-1
SN4000, 5-3, 5-6
SpectraSYSTEM LC (table), 5-2
Surveyor LC (table), 4-1
Waters Alliance and Alliance HT Separations Modules 

(table), 8-2

G
gases

nitrogen, 1-4
requirements, 1-4

H
HP 1100 Series LC

upgrade parts for Xcalibur-controlled device, 7-1
upgrading to Ethernet interface, 7-1
Xcalibur Upgrade Kit, 7-1
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I
I/O panel schematic, LTQ MS detector, 3-2
interface kits, for

additional 4-Port Serial PCB, 3-3, 10-1
contact closure, 3-3
HP 1100 LC, 7-1
SpectraSYSTEM LC, 3-3, 5-1
SS420x, 3-3, 8-1, 9-1
Waters LC, 3-3, 8-1

N
Notes

4-Port Serial PC, 10-2
bypassing the Surveyor column oven, 4-8
efficient fume exhaust system, 1-3
ground loops, 3-2
power conditioning devices, 1-2
reducing the delay volume, 4-8
replacing APCI sample tube, 2-3
SS420x, contact closure, 9-7, 9-9

P
parts, frequently used for plumbing (table), 11-2
power conditioning devices (note), 1-2
probe

APCI, connecting, 2-3
ESI, connecting, 2-2

R
reference manuals for SpectraSYSTEM, 5-2
rotary-vane pumps, 1-3

S
SN4000

configuring (figure), 5-5, 5-8
connecting

UV2000, 5-3
UV6000LP, 5-6

SpectraSYSTEM LC
components, 5-1
equipped with UV2000 (figure), 5-4
equipped with UV6000LP (figure), 5-7
firmware (table), 4-1, 5-2
reference manuals, 5-2
Xcalibur Interface Kit, 3-3, 5-1

SS420x
Acquisition page (figure), 9-6
Configuration page (figure), 9-8
configuring, 9-3
connecting Waters 2487 Dual Absorbance Detector 

(table), 8-6
External Events page (figure), 9-10
installing, 9-2
Interface Kit, 9-1
wiring diagram, 9-4
wiring scheme (table), 9-4
Xcalibur SS420x Interface Kit, 3-3, 8-1

Surveyor autosampler
connecting solvent lines, 4-7
hardware connections, 4-2
installation, 4-2
plumbing, 4-7

Surveyor LC System
cable diagram (figure), 4-5, 4-6
figure, 4-2
firmware (table), 4-1
plumbing modules, 4-7

T
TCP/IP addresses

Agilent 1100 Series Autosampler (figure), 6-5

W
Waters Alliance and Alliance HT Separations Modules

components, 8-1
Configuration dialog box (figure), 8-4, 8-5
connecting, 8-2
contact closure terminals (figure), 8-3
firmware (table), 8-2
wiring for contact closure (table), 8-3
Xcalibur Waters Interface Kit, 3-3, 8-1

X
Xcalibur

Contact Closure Kit, 3-3
kits for inlet devices (table), 3-3

Xcalibur data system
inlet devices

controlled by, 3-2
not controlled by, 3-4

Run Sequence dialog box (figure), 3-5
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